
Opening Doors
An introduction to digital accessibility.



Disclaimer
• Oklahoma statute authorizes ABLE Tech to coordinate with 

the Office of Management and Enterprise Services to provide 
technical assistance to agencies concerning the requirements 
of EITA in Oklahoma. This technical assistance is intended 
solely as informal guidance; it is not a determination of the 
legal rights or responsibilities of entities subject to Oklahoma 
statute or section 508.



ACCESSIBILITY
What is it?  Why do we need to worry 
about it?



Remember
• We are all designing for our future selves
• Jared Smith, WebAIM



What is digital accessibility?
• Technology compatibility
• Make digital content as understandable to technology as 

possible.
• Fair and equal
• Make the experience equivalent regardless of factors we cannot 

control.
• Universal access
• Don’t restrict anyone from getting where they want to go.



Technology 
Compatibility

• Make content 
understandable to 
technology.
• Searches
• Assistive technology 

(AT)



Fair and equal availability
• Make the experience as equivalent as possible regardless of 

what we cannot control.
• Computer type
• Tablet size
• Phone operating system
• Disability

• Visual
• Hearing 
• Motor
• Cognitive



Visual disabilities

• Blindness, low 
vision, color 
blindness, etc.
• Glasses
• Operating system 

zoom features
• Braille readers
• Screen reading 

software



VoiceOver
• Apple’s screen reading software
• Built in to Mac OS, iOS
• Sophisticated screen reader
• No Apple?  Try Non Visual Desktop Access (NVDA) for PC



Hearing disabilities

• Full/partial deafness
• Transcribed audio
• Captioned video



Technology as AT



Motor disabilities
• Carpal Tunnel Syndrome, full/partial paralysis, fine motor
• Keyboards
• Adaptive switches
• Breath controls



Wide spectrum of AT



Cognitive disabilities
• Behavioral, learning, sensory
• Calendar reminders
• Simplified content layout



Universal access

• Be intentionally 
inclusive.

• Don’t discriminate.



Accessibility is…
• …a matter of civil rights
• …not just a technology issue
• …decentralized
• …critical to employment



Opportunities for us
• Improve employment among people with disabilities
• Unemployment of people with disabilities is roughly twice the 

rate of people without disabilities
• Attract employers and employees from out of state
• Keep employers and employees from in state
• Improved web site search engine optimization, mobile device 

compatibility
• Possibly easier to maintain accessible content
• Reduce risk



General notes
• We already have most of the tools
• Making accessible content is easier in many authoring tools.
• Accessible material is easier for everyone to use.
• Headings 
• Color contrast
• Video captions for multilingual audience, large presentation 

space, quiet viewing, multimodal learning.



STANDARDS AND 
POLICY
Keeping everything consistent



International standards

• World Wide Web Consortium (W3C) 
Web Content Accessibility Guidelines 
(WCAG) 2.0

• Targets all content that uses web 
technology.
• Instructional material
• Course websites
• Administrative documents
• Web software
• Multimedia
• Plugins
• Etc.



Statute and policy
• Americans with Disabilities Act (ADA)
• Section 508 of the Federal Rehabilitation Act of 1973, 1998
• Department of Justice 

• Notices of Proposed Rulemaking
• Section 508 and Title II of the ADA due this summer
• Title III of ADA due in December

• Oklahoma Electronic and Information Technology Accessibility 
(EITA) statute, effective 2005
• Kept by Oklahoma Office of Management and Enterprise Services
• Look for your Accessibility Compliance Representatives in your agency



When lawyers get involved



Specific cases and 
programs
• Project Civic Access

• Eliminate “physical and communication barriers that prevent people with 
disabilities from participating fully in community life.”

• http://www.ada.gov/civicac.htm
• US Social Security Administration, 2009
• Arizona State University, 2009
• Penn State University, 2010
• New York University/Northwestern University, 2011
• Baltimore City Schools, 2012
• Sacramento, CA Public Library, 2012
• University of Montana, 2012
• Private sector: Healthcare, banking

http://www.ada.gov/civicac.htm


Legal takeaways
• Look before you leap.  Make accessibility a focus from the 

outset.
• Look at functional accessibility, not just compliance to standards.
• Purchase and use accessible products
• Best to catch a problem internally instead of dealing with a 

complaint
• Be proactive



Who is responsible?
• Vendors
• Purchasing agents
• Content authors/managers
• Administration and management
• Developers and designers
• Project managers
• Business analysts
• Policy makers/standard bearers
• Legislators
• Lawyers



In sum: POUR
• Perceivable
• Operable
• Understandable
• Robust



Perceivable
• Users must be able to perceive the information being 

presented 
• It can't be invisible to all of their senses

• If a user can’t get information into his or her brain, then it’s not 
helpful



Operable
• Users must be able to operate the interface 
• The interface cannot require interaction that a user cannot 

perform
• Input device independence



Understandable
• Users must be able to understand the information as well as 

the operation of the user interface 
• The content or operation cannot be beyond their understanding

• Content
• Navigation



Robust
• Users must be able to access the content as technologies 

advance 
• As technologies and user agents evolve, the content should 

remain accessible
• Future proof



Accessible 
Documents
7 steps to more accessible digital 
documents



Disclaimer
• We won’t cover everything you need to know in one hour, 

but…
• …you will be able to create more accessible documents
• …you will be able to generalize this information to web sites, 

software
• …we offer more in-depth training

• Examples are from Microsoft Word 2010



BACKGROUND
Some foundation to stand on



Presentational vs. Structural
• Presentational:  What the document looks like.
• Perceived visually.
• Breaking a document apart into sections, etc.

• Structural: Defines logical composition behind the scenes.
• Converting presentation into a language that other technology 

understands.
• Examples

• Word Style
• HTML mark-up
• PDF tag



Presentation and structure
• Make them match
• Convey the same meaning to broadest audience



How do documents fit?
• Make up lots of content on our sites
• Word
• PDF
• Excel

• Often central to consumer experience



CREATING MORE 
ACCESSIBLE 
DOCUMENTS
A primer



Your top 7 for today
• 7 things to make document content more accessible
• Make structural headings
• Make structural lists
• Write alternative text for visual elements
• Identify table header rows
• Think about how you use color
• Use links well
• Save files as tagged PDF files



Headings

• Presentational
• Establish logical 

structure
• Create content chunks
• Make a more readable 

document
• Structural
• Convey presentational 

information to 
technology.

• Navigation in Word 
2010, Acrobat Reader.

• Create a dynamic 
Table of Contents



Lists

• Presentational
• Organize related items.
• Easy to show priority with 

numbered lists.
• Structural

• Automatically assign 
numbers, change 
dynamically.

• Provide users of AT 
notice that there is a list 
and  ease navigation 
through lists.



Alternative text
• Concise and meaningful.
• Set context in body of document.

• Keep relevant text in close proximity to the visual element.
• No filenames, preferably no repeated captions.

• Aim for 120-140 characters.
• Also visible in Word, Reader on mouse-over
• Multi-modal learning aid



Context is key

• What does the 
image convey?



Add alternative text

Right click>Format 
Picture

Add in Description 
field



Tables
• Create tables through the Insert tab.
• Insert>Table

• Lay out tables with column headers, row headers if 
necessary.

• Identify one column heading row.
• Select the heading row.
• Right click>Table Properties>Row Tab>check Repeat 

as header row at the top of each page



Insert a table

• Insert>Table>click 
down arrow

• Insert Table… 
option lets you add 
more rows, columns



Simple table



Open Table Properties



Identify table header row



Challenge: complex table



Notes about color
• Keep color contrast high for better all-around readability.
• Primary problems are with visual elements and text.

• Don’t only use color to convey information.
• For example, don’t use red font color to emphasize text.

• Use Word Styles instead, like Emphasis.



Color contrast

Don’t do this…
Do something like 
this…



Verify contrast

• Check with The 
Paciello Group 
Colour Contrast 
Analyser



Color only

Don’t do this…Do this…



Links
• URL, Help text and Link text
• URL

• The actual web site address:  http://www.ok.gov/abletech/
• Link Text

• Words in the sentence that describe the link: Read more about 
Oklahoma ABLE Tech.

• Help Text/Screen Tip
• Text that appears on mouse-over and tells users where the link goes: 

Oklahoma ABLE Tech

• Sometimes both URL and Link Text are best

http://www.ok.gov/abletech/
http://www.ok.gov/abletech/


Insert a link

• Insert Tab>Links Group>Hyperlink
• Text to display = Link text
• Address = URL
• ScreenTip = Help Text



Export to tagged PDF
• Do not use Print to PDF
• Creates an image of the document

• Easy to do directly from MS Word
• File>Save As>PDF 
• Click Options button and verify that “Document structure tags for 

accessibility” option is selection in “Include non-printing 
information section”.

• Document is saved as tagged PDF.
• Verify accessibility with Acrobat Pro.
• For many to most documents, this will do the trick.



Word Accessibility Checker
• New in Word 2010.
• Helpful but not comprehensive.
• Can identify missing alternative text, etc. and point you at the 

specific issue.
• Can’t evaluate things like headings, lists.
• May have false positives.



Start a check



Accessibility Check 
report

• Shows issues
• Errors
• Need to address

• Warnings
• May be a problem, 

check manually



Multimedia 
accessibility
Transcription, captioning and playback



Policy and Statute
• Americans with Disabilities Act
• Title II and III

• Section 508 of the Federal Rehabilitation Act, amended 2008
• Oklahoma Electronic and Information Technology Accessibility
• 21st Century Video Accessibility Act



Audio and video
• Considerations
• Transcription
• Captioning
• Audio description
• Keyboard access



Transcript vs. caption vs. 
audio description
• Transcript
• Exact text that is spoken
• Most time and resource intensive piece

• Caption
• Transcript plus timing information for video

• Audio description
• Describes visual elements in video
• Separate track



Open and closed
• Open captions
• Overlaid on the video itself
• Cannot be turned on or off

• Closed captions
• Separate track from the video
• Can be turned on and off
• Resulting caption file can be basis for searchable, indexed file



Audio accessibility
• Podcasts, etc.
• Transcript does the trick
• Embedded player must work with keyboard



Video accessibility
• Captions required
• In sync with video

• Open or closed?
• Consider audience, media

• Compression of video will alter open caption appearance

• Embedded player must work with keyboard, screen reader



Embedded players
• Be navigable using a keyboard;
• Not interfere with accessibility features of other software or the 

operating system;
• Provide an on-screen indication of the current focus (the currently 

selected place of action);
• Provide information about the roles, states, and operation of each 

interface element to assistive technology;
• Use meanings consistently for any images that identify the 

software's controls, status, or program elements;
• Use the operating system to display text and contextual 

information;



More on embedded players
• Not override any user defined display settings in the operating system;
• Give users the choice of turning off animations and displaying information 

from the animations in other method;
• Not rely only on color to prompt users, or provide information or context;
• Provide a wide variety of color and contrast settings (only if the application 

allows users to adjust color and contrast);
• Not cause blinking or flashing at a rate greater than 2 Hz and lower than 

55 Hz; and,
• Ensure that users of AT are able to fully use and navigate through 

electronic forms, and provide any necessary cues and directions to the AT.
• From http://www.howto.gov/web-content/accessibility/508-compliant-and-

accessible-multimedia

http://www.howto.gov/web-content/accessibility/508-compliant-and-accessible-multimedia


WRAPPING UP
What do we do now?



General Priority
• Critical to participation
• High traffic
• Central point to fix
• Template, code library, contract language

• Resource availability



Checklists and resources
• Oklahoma EITA Technical Assistance Document
• http://www.ok.gov/about/documents/tad%202005.pdf

• WebAIM Section 508
• http://webaim.org/standards/508/checklist

• WebAIM WCAG 2.0 (A, AA and AAA)
• http://webaim.org/standards/wcag/checklist

• Accessibility Priority Tool
• http://usability.com.au/2013/01/accessibility-priority-tool/

• Goodwitch Hands-On Checklist
• Google ahoy…

http://www.ok.gov/about/documents/tad 2005.pdf
http://webaim.org/standards/508/checklist
http://webaim.org/standards/wcag/checklist
http://usability.com.au/2013/01/accessibility-priority-tool/


Tools
• Colour Contrast Analyser

• http://www.paciellogroup.com/resources/contrastAnalyser
• WebAIM

• Word http://webaim.org/techniques/word/
• PDF http://webaim.org/techniques/acrobat/

• Microsoft
• http://www.microsoft.com/enable/products/office2010/

• Adobe
• http://www.adobe.com/accessibility/products/acrobat/

• NetCentric CommonLook
• PDF http://www.commonlook.com/CommonLook-PDF
• Office http://www.commonlook.com/CommonLook-office

http://www.paciellogroup.com/resources/contrastAnalyser
http://webaim.org/techniques/word/
http://webaim.org/techniques/acrobat/
http://www.microsoft.com/enable/products/office2010/
http://www.adobe.com/accessibility/products/acrobat/
http://www.commonlook.com/CommonLook-PDF
http://www.commonlook.com/CommonLook-office


Resources
• WebAIM: Web Accessibility in Mind
• State of Oklahoma Accessibility pages
• Oklahoma ABLE Tech web and digital accessibility
• Oklahoma EITA Technical Assistance Document

http://webaim.org/
https://www.ok.gov/about/accessibility_policy.html
http://www.ok.gov/abletech/IT_Accessibility/index.html
http://www.ok.gov/about/documents/tad 2005.doc


Questions?
Rob Carr, Accessibility Coordinator
Email: rgcarr@okstate.edu
Oklahoma ABLE Tech
Oklahoma State University
1-800-257-1705
http://www.ok.gov/abletech/IT_Accessibility/inde
x.html
@okabletech on Twitter

http://www.ok.gov/abletech/IT_Accessibility/index.html

